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Preface

Intended Audience

Welcome to Release 3.0.2 of the Oracle Governance, Risk and Compliance Intelligence
Implementation Guide.

Oracle Governance, Risk and Compliance Intelligence (GRCI) Implementation Guide
for Release 3.0.2 is intended for information technology personnel and privileged users
responsible for installing and configuring the GRCI application.

See Related Information Sources on page viii for more Oracle E-Business Suite product
information.

Deaf/Hard of Hearing Access to Oracle Support Services

To reach Oracle Support Services, use a telecommunications relay service (TRS) to call
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle
technical issues and provide customer support according to the Oracle service request
process. Information about TRS is available at
http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone numbers is
available at http://www.fcc.gov/cgb/dro/trsphonebk.html.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible
to all users, including users that are disabled. To that end, our documentation includes
features that make information available to users of assistive technology. This
documentation is available in HTML format, and contains markup to facilitate access by
the disabled community. Accessibility standards will continue to evolve over time, and
Oracle is actively engaged with other market-leading technology vendors to address
technical obstacles so that our documentation can be accessible to all of our customers.
For more information, visit the Oracle Accessibility Program Web site at

vii



http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise
empty line; however, some screen readers may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

Structure

This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any
representations regarding the accessibility of these Web sites.

1 About Oracle Governance, Risk and Compliance Intelligence

2 Installing Oracle Governance, Risk and Compliance Intelligence 3.0.2
A ETL Execution

B Data Flow

C Logical and Physical Models

D Lineage for GRCC 8.6.0

Related Information Sources

Oracle Governance, Risk and Compliance Intelligence User’s Guide for Release 3.0.2.

This guide provides information on how to use the Governance, Risk and Compliance
Intelligence application.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data

viii

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an
Oracle E-Business Suite form can update many tables at once. But when you modify
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous



information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite
automatically checks that your changes are valid. Oracle E-Business Suite also keeps
track of who changes information. If you enter information into database tables using
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes.
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About Oracle Governance, Risk and
Compliance Intelligence

Product Overview

Oracle Governance, Risk and Compliance Intelligence (also referred to as GRCI, GRI, or
GRC Intelligence), Release 3.0.2, is an intelligence reporting application that extracts
data from Oracle Governance, Risk and Compliance Controls (also referred to as
GRCC), Release 8.6.0.

The Oracle Governance, Risk and Compliance Intelligence solution is designed to
enhance your visibility into the organization's compliance readiness and responsiveness
by providing out-of-the-box management reports relating to certification, controls,
issues, risks, and testing diagnostics. By using Oracle Governance, Risk and Compliance
Intelligence, you can drill from high-level to detailed information to effectively plan,
model, report, and analyze GRCI activities. You can identify potential issues early and
take informed and timely corrective actions.

About This Guide

This document explains how to install the Oracle Governance, Risk and Compliance
Intelligence application. The information contained in this document is subject to
change as the product technology evolves and as hardware, operating systems, and
third-party software are created and modified. This document is intended for
information technology personnel and authorized users responsible for installing and
configuring the Oracle Governance, Risk and Compliance Intelligence, Release 3.0.2
application.

About Languages

The Oracle Governance, Risk and Compliance Intelligence, Release 3.0.2, is available in
English for Oracle Governance, Risk and Compliance Controls, Release 8.6.0.
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This product supports all localizations for the following eleven tier-1 languages:

e Chinese Traditional

e Chinese Standard

¢ Spanish

e French

* Japanese

® Portuguese (Brazilian)
e Korean

e German

e TJtalian
e Danish
e  Dutch

Prerequisites

Before you use Oracle Governance, Risk and Compliance Intelligence, Release 3.0.2, you
must:

e Install Oracle Database 11gR2

Note: If Oracle Database 11gR2 has previously been installed, it is
not necessary to reinstall.

® Oracle Data Integrator 11.1.1.3.0
¢ Install Oracle Business Intelligence Enterprise Edition 11.1.1.3.0

* Install the following application:

® Oracle Governance, Risk and Compliance Controls 8.6.0

® GRCC Interface tables (tables with name starting as GRCC_DA_...) should be
deployed in the same schema as the tables for data warehouse ('GRI' Schema).
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Recommendation

It is recommended that the GRCC database installation and the GRCI data warehouse
database that has 'GRI' schema be in the same network.
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Installing Oracle Governance, Risk and

Overview

Compliance Intelligence 3.0.2

GRCI sources and extracts data from GRCC, and makes it available to users by storing
it in staging tables and transforming it into a star schema. Users can then access the
information using the out-of-the-box dashboards and reports. They can also, build their
own dashboards and reports using OBI EE, if required.

GRCI Sourced from GRCC

A tab called "Analytics Integration” is available on the "Application Configuration"
screen. This captures the setup information related to the integration.

Analytics Integration Schemas

The analytics integration component of GRCC application uses two schemas to
create necessary data for analysis by GRCI application. One schema (referred to as
ag_access) stores GRCC specific data in tables prefixed with LAA_ and TMP_ and
another schema (also referred to as gri or GRI) contains the staging tables used by
GRCI ETL process. This gri schema contains all database objects used by the GRCI
application.

Staging Tables Load

The gri schema contains the staging tables (prefixed with GRCC_DA), which act as
an interface between GRCC and GRCI applications. These tables are populated
when the user executes the Run process in GRCC application.

Note: Check the GRCC documentation for details on how to
configure the application to connect to GRCI staging schema and
load data into these staging tables.
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The staging (GRCC_DA_) tables are loaded during every execution of a Run and
data is updated in the staging tables in an update-else-insert fashion. Here are two
examples:

1. If the entitlement description or entitlement status changes in GRCC, the GRCC
data services component will pick up the changes during the next Run, and
update the staging tables GRCC_DA_ENTITLEMENT and
GRCC_DA_ENTITLEMENT TL with the new values.

2. If the status of an Incident changes from Assigned to Resolved in GRCC, the
GRCC data services component will pick up the changes during the next Run
and update the staging table GRCC_DA_ISSUE.

e  GRCI Star Schema Tables Load

Data in the GRCI staging schema is refreshed during every execution of a Run in
GRCC. So as a best practice it is recommended that GRCI administrator execute the
ODI based ETL packages immediately after every successful execution of a Run (for
ex: Run-1) in GRCC. This would refresh the content of GRCI star schema tables and
users can visualize the latest values in OBIEE based dashboards and reports.

In the GRCI staging area, information from the latest run overrides the information
of the previous run.

If the ETL packages are not executed after each run, the information for the run may
be overwritten in GRCI staging tables. Such overwritten information will not get
propagated to GRCI star schema tables.
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GRCC 861

Source

This chapter covers the installation procedures for GRCI 3.0.2 when the source
application is GRCC 8.6.0.

The following files are available:

¢ GRI_302_Common_Scripts.zip
* GRI_302_GRCC_Scripts.zip

e GRI_302_ODl.zip
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e GRI_302_OBIEE.zip

Installation involves:

1. Executing Scripts: Creating the Data Model and populating the configuration data.
2. Installing ODI.

3. Installing OBIEE Reports.

Executing Scripts
Overview

This section describes how to execute scripts against the database using the batch file
executing CallBatch, which in turn calls auto_load_scripts.bat or auto_load_scripts.sh.

The file GRI_302_Common_Scripts.zip contains the following files and folders:
1. ETL

2. Model

3. Seed_Translation_Data
4. auto_load_scripts.bat
5. auto_load_scripts.sh

6. ClassBatch.class

7. ConsoleEraser.class

The batch/shell file automates the entire script loading process to just one step. The
batch/shell file accepts the location of the script file directory as an argument.

Preparation Steps for Executing Script

Perform these steps before you run the batch/shell file. Once setup correctly this can be
used to run against multiple sources with minimal changes to the file.

1. Create a new schema/user for reporting schema.

If you are staging a schema (where grcc_da_xxxx tables are populated) from GRCC
is already available, use that schema; in that case, do not create the new schema,
skip the following step a.

a) create user gri identified by gri;
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Note: Assign the following roles and right to the newly created
user.

b) grant resource, connect to gri;

c) grant create view to gri;

d) grant unlimited tablespace to gri;
e) grant create table to gri;

f) grant Create procedure to gri.
Install SQLPlus on the machine where the batch/shell file will be run.

Download and Install xdk developer kit from the following location:

http://www.oracle.com/technology/tech/xml/xdk/software/prod/xdk_java.html

location:

http://www.oracle.com/technology/tech/xml/xdk/software/production10g/utilsoft.h
tml

Directions
Install GNU gzip.
Download the Oracle XDK for Java in .tar format.

Extract the distribution package into a directory. (Ex: #gzip -dc xdk_java.tar | tar
xvf -)

The result should be the following files and directories:

e /bin - xdk executables and utilities

e /lib - directory for libraries

e /xdk - top xdk directory

e /xdk/demo - directory for demo files

e /xdk/doc - directory for documentation

* /xdk/admin - direcory for dband config files
e /xdk/*html. - doc navigation files

e /xdk/license.html - copy of license agreement

Provide the connection details in tnsnames.ora if SQL client is installed, or provide
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TNS entry as described in example below.

Eg: DB_TNS=<host>:<port>/<service name>

5. Provide values for the following Environment variables in the batch/shell file. To
edit the batch file open it with any text editor and update the values as follows.

Environmental
Variable

USER_OPT

DB_TNS

DB_USER

DB_HOST

DB_PORT

DB_SID

Use

This variable is used
to as an option for
running the entire
script (scripts and
DLF) or only the
DLF load.

Used to provide the
oracle TNS to
connect to while
running scripts
using SQLPlus.

Used to provide the
Oracle database user
password.

This variable would
be used by transx to
load dIf files.

This variable is used
to set the database
port.

This variable is used
to set the database
sid.

Default Value

GRI

GRI

NA

1521

orcl

.bat Example

.bat:SET
USER_OPT=1

.sh :export
USER_OPT=1;

.bat :SET
DB_TNS=DEV_230

.sh :export
DB_TNS=DEV_230;

.bat :SET
DB_USER=gri

.sh :export
DB_USER=gri;

.bat:SET
DB_HOST=10.10.176
132

.sh :export
DB_HOST=10.10.176
132;

.bat :SET
DB_PORT=1521
.sh :export
DB_PORT=1521;
.bat :SET
DB_SID=grci

.sh :export
DB_SID=grci;
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JAVA_HOME

JDBCVER

INSTALL_ROOT

CLASSPATH]

ORACLE_HOME

To set NA
JAVA_HOME.

Comment this line if
already set.

To set the JDBC 12
version of the JDBC

files being used.

(values 11 or 12)

To set the xdk install ~ C:\xdk
root. "xdk" has the

transx files required

for dIf upload.

The location of the Default value
specified in batch

JDBC driver files
(classes12.zip and file.
nls_charset12 jar)

and xdb_g jar needs

to be supplied here.

To set NA
ORACLE_HOME.
Comment if already

set.

.bat :SET
JAVA_HOME=C:\P
rogram
Files\Java\jdk1.5.0_
16

.sh :export
JAVA_HOME-=/scrat
ch/user/jdk1.6.0_14;

.bat :SET
JDBCVER=12

.sh :export
JDBCVER=12;

.bat :SET
INSTALL_ROOT=C:
\xdk

.sh :export
INSTALL_ROOT=/s
cratch/user/Desktop/
transx;

.bat :SET
ORACLE_HOME=C:
\Apps\db\oracle10
2

.sh :export
ORACLE_HOME=/s
cratch/user/product/
11.1.0/db_1;

The database jdbc driver files should be available for transx to operate. The
required files are xdb_g.jar (available as part of Oracle database server install),
classes%JDBCVER%.zip and nls_charset%]JDBCVER%.jar (JIDBCVER being the
JDBC version being used).

The files nls_charset12.jar and classes12.zip are not part of Oracle 11g install.
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Download classes12.zip and nls_charset12.jar from the following location on OTN:

http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc9201.ht
ml

Oracle9i 9.2.0.5 JDBC Drivers -> nls_charset12. jar
Oracle9i 9.2.0.8 JDBC Drivers -> classes12.zip

Update the CLASSPATH] environment variable with the appropriate path for these
two files.

The file xdb_g.jar, needs to be located on the machine and the CLASSPATH]
variable needs to be updated accordingly.

IMPORTANT:PATH and CLASSPATH do not need any changes if the other
environment variables (INSTALL_ROOT, CLASSPATH], ORACLE_HOME and
JAVA_HOME) have been set appropriately.

7. Once the required changes have been made in the batch/shell file, save and close the
batch/shell file.

Execution Steps
Executing the scripts using CallBatch.
The steps to be followed to complete the execution are detailed below:
1. Unzip the file: GRI_302_GRCC_Scripts.zip

2. Open command prompt in Windows and shell in Linux and navigate to the location
of the folder - GRI_302_Common_Scripts.

3. Set the classpath: for Windows : set classpath=.;%classpath%; for Linux : export
CLASSPATH=..$CLASSPATH;

4. Assign permissions in case of Linux (chmod 777 auto_load_scripts.sh).

5. Execute the command: java CallBatch;
e a) Select Windows or Linux
* D) After selecting Windows or Linux, you must provide a path for
'GRI_302_Common_Scripts'. Provide the path where the folder

GRI_302_Common_Scripts are present. (.. for parent directory since we are
already in the folder.)

* ) Provide the path where the folder GRI_302_GRCC_Scripts are present. (.. for
parent directory since we are already in the folder.)
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¢ d) Enter the database password of the target schema

Important Information

The program execution results in the execution of auto_load_scripts.bat or
auto_load_scripts.sh.

The file "Execution.log" created in the GRI_302_Common_Scripts folder captures the
executing CallBatch message for review purposes.

Installing ODI Code

Setting up ODI Code and Importing ODI Code

The GRI_302_ODI_.zip contains the following files:

1.

Scenarios
auto_load_odi.bat
auto_load_odi.sh

Master_Repository.zip

Important: Please do not unzip Master_Repository.zip as ODI utilizes
this file in zip format.

Important: Set the value for Oracle database parameters PROCESSES,
SESSIONS and TRANSACTIONS as shown below.

Run the following commands as DBA user:

alter system set PROCESSES=600 scope=SPFILE;
alter system set TRANSACTIONS=700 scope=SPFILE;

alter system set SESSIONS=600 scope=SPFILE; Restart the database instance for the
changes to take effect.

The steps outlined below can be classified into 3 categories.

1.

Required for Master Repository Import: Steps 1 through 9

These steps would typically be performed only once during the life cycle of GRC
product. If the master repository has already been created and the connections have
been defined, the install starts from step 10 and the steps 1 to 9 can be ignored.
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2. Setup of odiparams.bat: Step 10

This is a one time activity which involves setting the batch file and providing
proper values for the environment variables used.

3. Import Objects: Steps 11 through 13

These steps are required to import the various objects that would be part of the ODI
code. Appropriate values for the variables needs to be specified while running the
auto_load_odi.bat / auto_load_odi.sh.

Setting up ODI Code and Importing ODI Code: Steps 1 through 13
1. Install ODL

2. Create a schema called gri_master.
3. From ODI 11g studio, File > New > Master Repository Import Wizard.

4. Provide appropriate values to connect to the database where the master repository
needs to be imported as shown below.
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. ‘Master Repository Import Wizard - Step 1 .0f 2

Repository Connection

[ Repository Connecti Database Connection

J.- Password Storage Login: [36_245_odi_masper v]
JOBC Driver: |0rac|e.jdhc.OracIeDriver | Q
JDEC Url: |jdbc:0racle:thin:@10.1?6.139.245:1522:0rcl2 | C&.
User: |odi_rnaster |
Password: e |

Repository Configuration

Id: (Mew Repository Id)
[w] Use a Zip File
Export Zip File: ||nd Settin-;s'l,lovﬁtllj1'l,Deskl:o|:-'I,GRI_3IJ2_ODI'|,Master_Re|:u:sitorv.zip| Ck
Technology: [Oracle vl

< J

.- < Back Iﬁ_M_extT] I Finish J | Cancel ]

e |

Select the appropriate Technology.

Provide a value of >10 for the ID and select "Use a Zip File" and provide the correct
path of the Master_Repository.zip file, supplied as part of GRI_302_ODI.zip.

After the master repository import wizard finishes successfully, open ODI
Topology Manager and "Update User Parameters".

Note: This is an important and mandatory step.
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®. [EGRCI Repository] Oracle Data Integrator 11g
File Edit W¥iew Search Tools Window Help

geo8g X ..;uxmm'zﬁncmmmr
M Repostary Connection Infsramation. . |

‘ Change Password

& Physical Architecture i

) Switch Password Storage ¥
, Locked objects

i Repostories

LUser Parametens

Changed Data Capture
Ganerake

P artmpbar Wihi Helgs
5 Bt OO prompt on ek IF this user puarameter b5 sek ko Yes the exck confirmastion diskog vall NOT Be: shawn. A
Irked sessions wih scenarios sk Hubomatically deletes sessions inked bo & scenario being deleted.
Hagpireg ask IF thes puaranmester i gek b0 brue, subnmatic mapping by mabching oolumn name will be perfomed when sdding & scurce o barg
th foid Louied Badaneinng o ek o ChyTubsaly Fieabonabad fiom (rkaded aQerts b s nbded spents.
P Intedd ace Diagram 1 Disghay & Halo maisage wheh the [ntbelos Dugr o i ssply
For cortumant edibng 1 Verdy that olijects hine fot beer modifed i the repoiliony by other users whien Laving changed,
maes. i the cache the list of models whose DBM... fo IF this usar pusrameter i ot botrus, the kst of model: whose DBMS i not socessble ks kept inthe cache, This spesds up exp.
100 [

et bo it thes number of slements depleyed in g branch of the Operstor Eresves.

e oy where the FOF repoets are genersted

Dbk Directory For Saving yous PG dagrams
G Dolaid Contt bor gomcukion
Cofmgiate Path b riur POF viimesw such 8 Adiles Aonobat R
=0 Query buffer s For OO repository J0BC connections. Orky appbeable to Crade J08T driver.
(=1 Dk st contet used n Designes
Locdl (o fgent)  Dsfauk Agent used For execution and control
0000 Timeot used by Oracle Diata Inbegrstor for the databace connedtions.
1508855 _1 Export default Lava ercodng
150-535%-1 Db pit XML charset encoding
paet el et veesion .0 Expeet ol gt o sion
i It D il o s U e 1 “Sreceves e OO medlications in the tres (1 D=Erabilod Deksbind)
resounce rames inthe tres, Yoz Displary resource nsmes in the bres,
%Nﬂmm SLORECT_MAMEY. The comventon bouse whean naming & Soersnio, e
L] >

7. Provide JDBC Connection Details for database GRI 3.0.2.

Important: Make sure that the data server names are not changed.

Select the physical schemas that have to be mapped to these data servers.
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. [EGRCI Repository] Oracle Data Integrator 11g

File Edit Yiew Search 0ODI Tools Window Help
Eo@ag xam p»

Designer [E'rmluw | i operator =)
@

[

= Physical Archibecture |
= [ Technologies ud

| artunity

- Avisz

[ ETrieve

[ DBase

& _JDerby

- _dFile

[l Myperion Esshase

& [_jHyperion Financial Management

& |l Hyperion Planning

i [ Hypersonic SQL

[l IEM DB LDE

Edit the Oracle technology and provide database connection details for GRI data
servers.

File Edit VYiew Search 0OD1 Tools Window Help
Foag XxXam»

yDesigner | {5 Topology | . Operator =]
)

= Phoysical Architecture |
S EATTT B
@[ JLoap
B[ Microsoft Access
[ [_j Microsoft Excel
[ [ Microsoft S0L Server
& (IMysaL
B[ NetRess
B[ etezza
- [JOD! Tooks
@ (_J Operating System
R [
& (EGRCM
= SED
= fRcrchr
& [[] Datatypes
- Actions
&= Index Type
@ Oracls BAM

Double Click on GRI. Provide Connection > User and Password Details.
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Deu |

»| @

Test Connaction

Delination
o D pata Server
Propertes Hame: =
Data Souroes e .
Wersion
Privieges Freitare | bk (Dabh Servar]:
le Conmectsn

Lsér: farh

Pasgwind;  wee

DI Conrecton
Arriy bk Se: (30 Bahch Ligclate Soe: 30

Change to JDBC Tab and modify JDBC URL with Hostname, Port# and SID.

| [ Bem 5]
Test Connedtion ¥

Test Connection and Close.

Double Click on Physical Schema "GRL.GRI" and make sure that the proper physical

schemas have been selected, i.e. Schema and Work Schema. If it is not GRI change it
to the correct schema.

aRLaR] o
Oelinition 0 3
(P Phiysical Schenia [Data Server: GRI]
Nergion Bane:
Tk (Schmmal: R -
FlexFields
Schema (Wiwk Schema):  (GRI -
| Daf st
‘Work Tables Prefic
Errors: ER_ Losdng: T, Integration: T4 Temporary Indsces: T
Sournalizirg elements prefioes
Diataatores: 2§ Lo Triggers: | T4
= Maming Rules
Local Clgact Mask: L STHEMA, OB ECT

Remote Object Mask:  SASCHEMA. OB EC TE S DSERVER

Partiion Mak: [ SCHEMA, Wil ECT PARTITICN SRR TITION)
Saub-Partiton Mash: 5 SCHEME, OB JECT SLEFARTITIONWPAR TITION)
Local saquence mask: [HSCHEMA, OB ECT . nextval

Roamite soqeencs mas: SHSCHEME, %0l HCT nextvalreEEn iR

8. Create a schema called gri_work.

9. Open Topology manager and insert a work repository (Provide the database user
created above in Step 8 in the JDBC connection details.).
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Create the Work Repository with ID value greater than 10 (Not same as Master
Repository ID) as shown in image below.

% [EGRCI Repository] Oracle Data Integrator 11g

File Edit ¥iew Search 0ODI Tools Window Help
Begg xamp>

yDesigner | i Topology | .l Operator .
@ &i-
[+ Physical Architecture

b Contexts &5 -
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®. Create Work Repository - Step 1 of 2

Specify OD1 Work Repository connection properties

Technology: | Oracle

Liger: [n-i_rmt

T ——

|
J0BC Drtver: [oracle.jdbe.OracleDriver | &
B U [jdbe:oracke:thin: GadcB0070ferms. us.cracle.com: 1538 Friwodi02 | &
|
|

Test Connection

e e

Test Connection and Click "Next".
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®. Create Work Repository - Step 2 of 3

Specify the password of the ODI Work Repository to attach
Puwd:[
Messages:
| <pack | mext> || con || cancel |
—

You can leave it as blank or provide password if required.
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10.

®. Create Work Repository - Step 2 of 2

Specify OD1 Work Repository properties
1d: fis |
Marne: |Tzsmm|<REPm |
Pascword: | |
Work Repository Type: [w-ehprm .-]
Messages:

o | (] [Ccmen ]

Provide ID and Name.

Click "Finish".

Set up the odiparams.bat/odiparams.sh file.

Depending on the OS being used to setup ODI selection of odiparams.sh or
odiparams.bat needs to be made.

odiparams.bat/odiparams.sh is available in ODI_HOME\bin (Windows) or
ODI_HOME/bin (Linux).

Locate the file and edit it using any text editor to update values for the following
parameters:

Environment Value Use Example
ODI_SECU_DRIVER This variable provides bat:
information about the driver ODI_SECU_DRIVER=oracle.
which will be used for jdbc.driver.OracleDriver
database connection. We
would be using the JDBC sh:

ODI_SECU_DRIVER=oracle.
jdbc.driver.OracleDriver

drivers to connect to Oracle
in most cases.
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ODI_SECU_URL

ODI_SECU_USER

ODI_SECU_ENCODED_PA
SS

ODI_SECU_WORK_REP

This is the driver URL to be
used to connect to the
database.

The username of the master
repository schema.

The encoded password for
master repository database
user. Steps to encode
password described above.
The password to be placed
here needs to be encoded
using ODI's encoding agent.

1. Encoding program path

is <ODI_HOME>
\agent\ bin (Windows)
or ODI_HOME> /agent
/ bin (Linux)

Windows command: is
"encode
<PASSWORD>"

Linux command: is
" Jencode
<PASSWORD>"

Name of the work
repository.

.bat :set
ODI_SECU_URL=jdbc:oracl
e:thin:@DB:1521:0rcl

sh:
ODI_SECU_DRIVERs=jdbc:o
racl e:thin:@DB:1521:o0rcl

.bat :set
ODI_SECU_USER=gri_mst

.sh:
ODI_SECU_USER=gri_mst

Jbat:
ODI_SECU_ENCODED_PA
SS=c6yHoUsvzzG6yGOwSey

qqqQb

sh:
ODI_SECU_ENCODED_PA
SS=c6yHoUsvzzG6yGOwSey

qqqQb

.bat:
ODI_SECU_WORK_REP=0O
DI_WRK_1

sh:
ODI_SECU_WORK_REP=0
DI_WRK_1
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ODI_USER The ODI username. .bat:
ODI_USER=SUPERVISOR

.sh:
ODI_USER=SUPERVISOR

ODI_ENCODED_PASS The encoded password for .bat :set

ODI user. This password is ODI_ENCODED_PASS=LEL

already set for KIELGLIMDLKMGHEH]JDB

SUPERVISOR password GBGFDGGH

SUNOPSIS and requires no

change if no additional ODI -sh:

users have been created. The ODI_ENCODED_PASS=LEL

password to be placed here KIELGLJMDLKMGHEH]DB
GBGFDGGH

needs to be encoded using
ODI's encoding agent.
Navigate to <ODI_HOME>
\agent\ bin (Windows) or
<ODI_HOME> /agent/ bin
(Linux) at command prompt
(Windows) or terminal
(Linux) and execute the
following command:
"encode <PASSWORD>"
(Windows) or ".Jencode
<PASSWORD>", here
<PASSWORD?> represents
the actual password.

11. Loading the ODI environment.

ODI_JAVA_HOMEneeds to be set for the shell script auto_load_odi.sh, this should
point to the java home location.

INSTALL_FILEis the location of the folder GRI_302_ODI for Windows or
GRI_302_ODI for Linux

ODI_HOME:is the location of ODI home where the file is to be executed.

12. a) Using auto_load_odi.bat

Make sure that odiparams.bat has values set for all environment variables listed
above in Step 10. Open a new command prompt and navigate to the folder having
the file auto_load_odi.bat, execute the following command.

C:\GRI_302_BIP_ODI> auto_load_odi.bat

) b) Using auto_load_odi.sh Make sure that odiparams.sh has values set for all
environment variables listed above in Step 10. Open a new command prompt and
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navigate to the folder having the file auto_load_odi.sh, execute the following
command. Assign permissions to auto_load_odi.sh file(chmod 755
auto_load_odi.sh).

Jauto_load_odi.sh

The successful completion of the process would end in the ODI objects (interfaces,
packages, etc.) being imported correctly. To log the execution messages for review
later.

Jauto_load_odi.sh>/odi.log

13. Open "Operator" connecting to the master and work repository created above.
"GRI_MASTER_PKG Version 001"
Go to Scenarios tab, locate the files "GRI_MASTER_PKG Version 001"
The execution can be monitored for the Operators Execution tab.

IMPORTANTOn Triggering GRI_MASTER_PKG Version 001, a prompt for input
values of pkg variables appears. The value for USER_ID can be supplied here, this
USER ID will be populated into the WHO columns (CREATED_BY,
LAST_UPDATED_BY and LAST_UPDATE_LOGIN) that are part of each GRI table.
This is an informational field, providing value for USER_ID is optional.

Installing OBIEE Reports

The following files are available in the GRI_302_OBIEE.zip download:

Note: This is required for OBIEE reports/dashboards.

* GRCDiagnostic.zip

¢ GRCDWebcat.zip

* productmessages.xml
*  CcOommon.css

¢ login.css

These files contain the repository, web-catalog and the files to be used for branding the
product. The files will be used in the steps below to install the repository and
reports-dashboards respectively.

1. After you successfully install OBIEE, extract the delivered zip file
GRCDiagnostic.zip. Place the GRCDiagnostic.rpd file in the
F:\Home\ instances\instancel \ bifoundation\ OracleBIServerComponent\ coreappl
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ication_obis1\repository folder.

2. Place the GRCDWebcat.zip file in the
F:\Home\ instances\instancel \ bifoundation\ OracleBIServerComponent\ coreappl
ication_obisl\ catalog folder and unzip the file. The GRCDWebcat folder now
appears in the Catalog folder.

3. After uploading GRCDiagnostic.rpd and providing the path for GRCDWebcat, you
click on (B) Apply followed by the (B) Active Changes. Go to OBIEE 11G
WEBLOGIC admin console, Farm_bifoundation_domain --> Business Intelligence
--> coreapplication --> Deployment tab --> Repository tab --> Click on "lock and
edit", use the Upload BI Server Repository to upload the GRCDiagnostic.rpd; Use
the Presentation Service Repository to point the location of GRCDWebcat folder.

ﬁ 4 e o 1 kg L0, 76,135, 2482001 femifaces/afbifinstance”_acf ctrbstabesbibrsptyr 5t argeta 3P am_bfoundation don 7 - -‘! - obise | Igwebcst p
|| Orace Bl Interactiy. | [ Orace Business It | | ] Business Int... £ | [ Gossay Mg AR - auomated B | [ Governance, Risk s | (2] National Stock Exch... |
ORACLE Enterprise Manager Fusion Middisware Cantrol 11g Setp w Help~  LogOut
HiFemy | & Topohogy

m- coreapplication @ Loged in & Admin
3 Farm_bifourdation_domain (] Business Inkeligarce Instance Page Eefrathed Gct B 2030 JiX0:08 BV GHIT 80 T2

[ Apphcation Deployments

7l [ Weblogic Doman i warning
= [ Business Inteloancs Sooligralin bri

B8 Rcation Overview  Capschy Management  Diagnostics  Seourty | [Deploynment
i [ Metadata Repashones Presentaticn  Repository  Schedder  Macksting  Mal

Cofaut RFO  GRCDRSgnostic_11G_ETDO0Z
Shared Location
Upload Bl Server Repository

LU itz sction to uplosd & new FPD and s password to your Bl Server domain. You may slso use this section bo re-enter the password F
& mistake was made on a previous upload,

Prisentation Service Repository

This section shows the curment locstion of presentation reposbory For the presentation seevices. Yiou can Lse this section ko change the
repcskony kecation and pont to shared location b adheve shared catakeg

Jog Location  FORACLE_INSTANCE b oundation]OrackBIPresent ationServicesComponent $COMPONENT_NAME catalog
GRCTAshat

4. Create the TNS entry to point to your GRCI schema in Oracle home directory; E.g:
F:\Home\ Oracle_BI1

5.  Open the GRCDiagnostic.rpd in the Oracle BI Administration Tool and go to the
Variable Manager under the Manage > Variables menu.

6. Update the GRI_DSN variable with the name of the TNS entry name.
7. Update the GRI_USER_ID with the database user ID.

8. Open the properties window for 'GRC Diagnostics > GRCI Connection Pool' in the
Physical layer and provide the password for GRCI schema.

9. Save the changes in the Oracle BI Administration Tool.
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10.

11.

12,

13.

14.

Place the files delivered as part of GRI_302_OBIEE.zip as mentioned below:

File "productmessages.xml” Place this file at
<MiddlewareHome>\ Oracle_BI1\bifoundation\ web\msgdb\1l_en\messages\
productmessages.xml.

File "common.css" Place this file at:

<MiddlewareHome>\ user_projects\ domains\bifoundation_domain\servers\<
BI_SERVER>\tmp\_WL_user\analytics_11.1.1\7dezjl\ war\res\sk_blafp\b_m
ozilla_4\rtl\ common.cssand at

<MiddlewareHome>\ user_projects\ domains\bifoundation_domain\servers\<
BI_SERVER>\tmp\_WL_user\analytics_11.1.1\7dezjl\ war\res\sk_blafp\b_m
ozilla_4\ common.css.

File "login.css" Place this file at:

<MiddlewareHome>\user_projects\ domains\ bifoundation_domain\servers\<
BI_SERVER>\tmp\_WL_user\analytics_11.1.1\7dezjl\ war\res\sk_blafp\logi
n\login.cssand at

<MiddlewareHome>\ user_projects\ domains\ bifoundation_domain\servers\<
BI_SERVER>\tmp\_WL_user\analytics_11.1.1\7dezjl\ war\res\sk_blafp\logi
n\rtl\login.css.

Restart the Oracle BI Services.

Log into the OBIEE using this URL: http://<localhost>:<TCPport>/analytics, where
<localhost> is the name of the machine or the IP address where OBIEE is installed,
and <I'CPport> is the Web Site TCP Port number.

The OBIEE login page loads.

The installation is now complete.
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A

ETL Execution

This appendix covers the following topics:
* Execution Sequence for GRCC
e ETL Execution for GRCC

e Execute a Scenario

Execution Sequence for GRCC
Order of Execution for the ETL:
The following packages are placed into a single package GRI_MASTER_EGRC_PKG.
1. GRI_DIMENSIONS_PKG

2. GRI_BRIDGE_TABLES_PKG
3. GRI_FACTS_PKG

The order for execution of the GRI_DIMENSIONS_PKG is as follows:
1.  GRI_INSTANCE_PKG

2.  GRI_GENERIC_DIM_PKG

3. GRCD_USER_MAIN_PKG

4. GRI_POLICY_PKG

5. GRI_ENTITLEMENT_PKG

6. GRI_ACCESS_POINT_PKG

7. GRI_APPS_USER_PKG
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8.

9.

GRI_D_PATH_EXCLUSION_PKG

GRI_D_ROLE_PKG

Note: Steps 4-8 may be run independent of each other, but the rest
should be run in numeric order.

The following packages present in the GRI_BRIDGE_TABLES_PKG. They should be
run after the loading of all the dimensions. The bridge tables can be run independent of
each other.

1.

GRI_D_ROLE_USER_BG_PKG
GRI_D_POLICY_GENERIC_DIM_ BG_PKG
GRI_POLICY_DETAIL_BG_PKG
GRI_D_ENTLMNT_GENERIC_DIM_BG_PKG
GRI_D_ENTITLEMENT_AP_BG_PKG

GRI_D_USER_ACCESS_BG_PKG

The GRI_FACTS_PKG contains the following packages for loading the incidents and
they should be loaded in the following order and only after the loading of the
dimensions and bridge tables.

1.

GRI_F_INCIDENT_ALL_PKG
GRI_F_INCIDENT_ACCESS_PKG
GRI_D_INCIDENT_TAG_BG_PKG
GRI_D_INCIDENT_PARTICIPANT_BG
GRI_F_CONDITION_ALL_PKG
GRI_F_TCG_INCIDENT_PKG
GRI_A_TCG_CNTRL_LABELS_PKG
GRI_D_CONTROL_PARTICIPANT_BG_PKG

LOAD_DYNAMIC_ATTR_NAMES
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ETL Execution for GRCC

In the ODI Operator module, (N) Scenarios; the user can then locate the following
master package scenario: GRI_MASTER_PKG Version 001.

The fact, dimension and bridge tables related scenarios are found using the same
navigation as above.

There are three ETL Execution options for GRCC:
Option 1:
1.  Execute GRI_MASTER_PKG Version 001 Scenario.

2. This action triggers all the scenarios required to load the entire star schema.

Option 2:

Important: Execute the scenarios in the following order.

1.  GRI_DIMENSIONS_PKG Version 001 — this scenario will load all the dimension
tables.

2. GRI_BRIDGE_TABLES_PKG Version 001 — this scenario will load all the bridge
tables.

3. GRI_FACTS_PKG Version 001 - this scenario will load all the fact tables.

Option 3:

Run individual table level scenarios, in the same order as in Option 2.

Execute a Scenario

In order to execute a scenario, navigate to the ODI Designer and locate the required
scenario to execute.

Right click on that scenario, and then click Execute as shown below:
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B [EGRCI Repository] Oracle Data Integrator 11g

File Edit Wiew Search 0OD1 Tools Window Help
Beag XEm b

AyDesiorer | £ Tepology | Dperatar [=)
o7 e = -
- Segsaon List

I+ Hierarchical Sessons

b Scheduling

~ Seearios [

& S GRI_D_INSTANCE_PKG Version 001 -
& S GRI_D_INSTANCE _TL_PES Version 004

& S GRI_D_PATH_EXCLLISION_PG Yersion 001

& EEGRI_D_POLICY_DETAIL_BG_PEG Version 001

& S GRI_D_POLICY_GEMERIC_DIM_BG_PYG Yersion 001
& EEH GRI_D_POLICY PG Yersion D01

& EE GBI _D _POLICY _TL_PYIS Versied 001

& [ GRI_D_ROLE_PYG Yersion 004

B S GRI_D_ROLE_TL_PYG Wersion 001

& EH Rl _D_ROLE_USER_BS_PRG Version 001

& GRI_D_USER_ACCESS_BG_PKG Yersion 001

& EE GRI_ENTITLEMENT _PYG Version 001

& [ GRI_FACTS_PKG Yersion 001

& EEGRI_F_CONDITION_ALL_PY¥G Versian 001

& GRI_F_CONDITION_PEG_1 Virsian 001

& EE GRI_F_CONDITION_PXG_Z Version 001

& EE GRI_F_CONDITION_PEG 3 Viersion 001

& EEHaRl_F_INCIDENT _ACCESS_PRG Version 001

& (EEGRI_F_INCIDENT _ALL_PYG Yersian 001

S GRI_F_TCG_INCIDENT _PKG Version 001

& SEGRI_GEM_USER_PRS  Open

S aaml_mm_mHJ e
. GRI_INSTANCE_PRG| °
ey okt wen
- EE GRI_POLICY_PKG Ve| 26 Delete Gatata
@GR _ROLE_PEG Ver ——
& S5 GRI_S_INCIDENT_P
@ SEGRI1_S_INCIDENT_T Lot ¥
& {55 LOAD_CTRL_INCIDE Expemt
& EEHLOAD_DYNAMIC_AT Encryrk
& 35 TEMP_BATCH_ID_V.
- am;mcn_m_vq : S :
@ @Euser_io verson oot TN g
= Solutions. W Wergon L3 _"ﬁ'

In the Execution window, select the context that was created as part of the ODI Code
installation.

Click OK. This starts a session for the executed scenario.
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ST GRI_FACTS_PHG Yarsion 001

S GRI_F_COMDITION_ALL PG Wersion DOY
S GRI_F_CONDITION_PKG_1 Yersion 00X

- S cRi_PF_CONDITION_PKG_2 Version 001

&SGR _F_CONDITION_PKG_3Version 001

b 59 GRI_F_INCIDENT_ACCESS_PHG Viersn 001
& 5 GRIF_INCIDENT_ALL _FKI5 Ver:sn 0O

- S GRI_F_TC_INCIDENT_FXG Warson 001

- S GRI_GHL_LISER_PR0KC Version 001

S R0 _GENERDC_DIML PG Version 001

- 55 GRI_INSTANCE P0G Version D01

R CHLL_MUS TER_FY.G Version 001

S GRI_POLICY PG Version 0l

B S GRI_ROLE_PHIS Warsn 001

S GRI_5_NCIDENT_PARLEST_TEMP PG Version 001
S GRI_S_INCIDENT_TAGLIST_TEMP_PEG Wersion D01
- S Lowd_CTRL _INCIDENT BIELATE_PROC Version (0L

The status of a session and its corresponding steps and tasks can be checked in, in the
ODI Operator module.

In case of a higher-level package, such as one encapsulating multiple child packages,
the status for each child package session can also be monitored.
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Gbesigner | i Topokogy [ Operator =

R DS -
I Sesshon Lisk
= Heerarchical Sessions

= [ pake
® Taday (Dec 2, 2010)
=]

= &B 755010 - GRI_MASTER _PKG - Dec 8, Z010 10:05:14 PM
@ EF varishiles
= 5 Steps
G 0 USER_ID Dec 8, 2010 10:05:14 PM
-G | COUNT_BATCH_ID_VAR Dec 8, 2010 10:05:14 PM
i P 2 Execution of the Scenatio BATCH_ID_ Dec 8, 2010 10:05:14 PM
& 3 COUNT_BATCH_ID_VAR Dec 8, 2010 10:05:15 PM
g 4 Execution of the Scensrio GRI_DIMEN Dec &, 2010 10:05: 18 PM
&€ S Execution of the Scenario GRI_BRIDG Dec 8, 2010 10:08:56 PM
& & Execution of the Scenaio GRI_FACTS Dec &, 2010 10:09: 12 PM
-G 7 COUNT_BATCH_ID_VAR Dec 8, 2010 10:11:44 PM
= 1§ Chid Sessions
= Q) 862010 - GRI_FACTS_PKG - Dec 8, 2010 10:09:12 PM
H5 varisbles
&g Steps
= H Child Sessions
& 904010 - DECR_COUNT _BATCH_ID_VAR_PEG - Dec &, 2010 10:11:44 PM
G 903010 - LOAD_DYMAMIC_ATTR_MAMES - Dec 8, 2010 10:11:40 PM
=) S00010 - GRI_D_CONTROL_PARTICIPANT _BG_PKG - Dec &, 2010 10:11:36 PM
@ G variables
= % Steps
& @0 - Execution of the Scenaro BATCH_ID_ - Dec 8, 2010 10:11:36 PM
&G 1 - GRI_RUN_INTR_HIST_PROC - Dec 8, 2010 10:11:36 PM
& G2 - LOAD_CONTROL_PARTICIPANT_BS - Dec 8, 2010 10:11:33 FM
-3 - GRI_RUN_INTR_HIST_PROC - Dec 8, 2010 10:11:39 PM
& )4 - Execution of the Scenario DECR_COUN - Dec 8, 2010 10:11:40 FM
=95 Child Sessions
@ H02010 - DECR_COUNT_BATCH_ID_VAR_PKG - Dec 8, 2010 10:11:40 PM
&4 01010 - BATCH_ID_PKG - Dec 8, 2010 10:11:36 PM

P 599010 - LOAD_CTRL_INCIDENT_RELATE_PROC - Dex &, 2010 10:11:32 PM w
I Scheduling 1
[ Seanarios (7 g
I Solutions -

Verify that the scenario has run successfully. The result of each task execution can be
viewed in the Execution tab of Session Task window.

Verify the number of rows processed as part of each task in the session.

Note: Please refer to the Oracle Data Integrator User's Guide for more
detail on using the ODI Designer and ODI Operator modules.
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Data Flow

This appendix covers the following topics:

¢ Data Flow Diagram

Data Flow B-1



Data Flow Diagram

GRCC 86.1

Source
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Logical and Physical Models

This appendix covers the following topics:
¢ GRCI3.0.2 - GRCC 8.6.1 Logical Model
¢ GRCI3.0.2 - GRCC 8.6.1 Physical Model

GRCI 3.0.2 - GRCC 8.6.1 Logical Model

e Control Detail

Control Detail

P." Datasource Control
Grain: Control, Detail Type, Access
Point, Control Effective Date

Control Count
Active Control Count
Inactive Control Count

Entitiement Count
Access Point Count
Datasource Count
Process Count
Risk Count

(T T

Access Point

T} partcisan = [ orccuser

Time Series(YAgo, QAgo, MAgo). ntitlemen

Particiapnt
Group

- e AN (1

Time hierarchy:
Year -> Quarter -> Month -> Day

Control hierarchies:

Control Type -> Control Name
Control Priority -> Control Name
Pracess -> Contral Name

Risk -> Contral Name

Access Point hierarchy:
Access Point Type -= Access Point Name

e Incidents
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Incidents

Grain: Incident, Incident Version

Access Point "
{ vig Incident Type

&
Incident Status
Incident Created Date

Incident Closed Date
Incident Updated Date

Incident Age
Incident Count
Pending Incident Count

Application User Count

(3 Rl 7S

Privilege Count
Time Series(YAgo, QAgo, MAgo)...

Y {} Veson pate

{1} Fen A G

Time hierarchy:
Year -> Quarter -> Month -> Day

Control hierarchies:

Control Type -> Control Name
Control Priority -> Control Name
Process -> Control Name

Risk -> Control Name

Access Point hierarchy:
Access Point Type -> Access Point Name

e Conditions
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Y

{ Exclusion/
Condition Type

Generic
dimesion Type

{ Exclusion/
Condition Value

AN

Generic
dimension
@ Usar

Time hierarchy:
Year -» Quarter -> Month -> Day

Control hierarchies:

Control Type -= Control Name
Control Priority -> Control Name
Process -> Control Name

Risk -= Control Name

Access Point hierarchy:
Access Point Type -> Access Point Name

Path Conditions

Application
Liser

Access Point
(Exlude)

0 b

Control hierarchies:

Contral Type -> Control Name
Control Priority -> Control Name
Process -> Control Name

Risk -= Control Name

Access Point hierarchy:
Access Paoint Type -> Access Point Name

User Access

Condition

Grain; Condition Type, Condition
Value, Policy, Data source

Condition Status
Condition Name
Condition Description
Filter Name
Exclude Flag

Condition Count
Control Count

Path Conditions

Grain: Datasource, User, Access
Point, Access Point — From, Start
Date

Condition Path Start Date
Condition Path End Date

Condition Path Status
Condition Path Action
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User-Access

Grain: Datasource, Application User,
Access Point- Role

Assignment Start Date
Assignment End Date

Delete Flag

A Paoint o 5 g—o : Assignment
Application Liser Count n‘ { S[HI‘?DEIS

Access Point - Role Count

GRCI 3.0.2 - GRCC 8.6.1 Physical Model

e Access Point

C-4 Oracle Governance, Risk and Compliance Intelligence Implementation Guide



=] GRI_D_ACCESS_POINT_TL

ACCESS_POINT_SID : MUMBER
LANGUAGE : VARCHAR2(4)
INSTANCE_SID : NUMBER
SRC_SYS_D : VARCHAR2(S)
SOURCE_LANG | VARCHAR2(4)

ACCESS_POINT_MAME : VARCHARZ({256)
ACCESS_POINT_DESC : WARCHARZ(1024)
ACCESS_POINT_TYPE_MNAME : VARCHARZ(256]

BATCH_ID : NUMBER
CREATION_DATE : DATE
CREATED_BY : NUMBER
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY . NUMBER
LAST_UPDATE_LOGIN : NUMBER

@J GRI_D_ACCESS_POINT_WL

B.ACCESS_POINT_SID
B.ACCESS_POINT_ID

TL LANGUAGE
BINSTAMCE_SID
B.SRC_SYS_ID

TL ACCESS_POINT_MAME
TL.ACCESS_POINT_DESC
TL.ACCESS_POINT_TYPE_MAME
B.ACCESS_POINT_CODE
B.ACCESS_POINT_TYPE_CODE
B.ACCESS_POINT_START_DATE
BLACCESS_POINT_END_DATE
B EFFECTIVE_START_DATE
B.EFFECTIVE_END_DATE
B.CURRENT_IMD

BBATCH_D
B.CREATION_DATE

B .CREATED_BY
BLAST_UPDATE_DATE
BLAST_UPDATED_BY
BLAST_UPDATE_LOGIN

Control

o1 | ACCESS_POINT_CODE : VARCHARZ(256)
ACCESS_POINT_TYPE_CODE : WVARCHAR2(258)
ACCESS_POINT_START_DATE: DATE

= GRI_D_ACCESS_POINT

ACCESS_POINT_SID : NUMBER
ACCESS_POINT_ID : NUMBER
INSTANCE_SID : NUMBER
SRC_SYS_ID: WARCHAR2(S)

ACCESS_POINT_EMND_DATE : DATE
EFFECTIVE_START_DATE : DATE
EFFECTIVE_EMD_DATE : DATE
CURREMT_IMD : VARCHAR2(1)
BATCH_ID : MUMBER
CREATION_DATE : DATE
CREATED_B : NUMBER

| 7|LAST_UPDATE_DATE: DATE

LAST_UPDATED_BY . NUMEBER
LAST_UPDATE_LOGIM : NUMBER

«UK» GRI_D_ACCESS_POINT_UK1 : ACCESS_POIN'

;I:’: TL{GRI D ACCESS POINT TL})

Logical and Physical Models
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i) GRI_D_POLICY_TL

POLICY _SID : NUMBER(15, 0)
LANGUAGE | V.ARCHARZ(4)

SRC_SYS_D : VARCHAR2(S)
SOURCE_LANG : VARCHAR2(4)
POLICY_NAME : VARCHAR2(258)
POLICY_DESC : VARCHAR2(1024)
POLICY_COMMENTS : VARCHARZ(1024)
POLICY_EXPRESSION : VARCHARD(1024)
POLICY_STATUS_DESC : VARCHARZ(1024)
POLICY_TYPE_DESC : VARCHARZ(1024)
BATCHD : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

<Uks GRI_D_POLICY_TL_U1 : POLICY_SID, L.

<FH CRI

_POLICY _TL_FK1 : POLICY_SID

B8] ORID_POLICY_VL

GDP POLICY_SID
GDP POLICY_ID

GDP POLICY_VERSION_ID
GDPTL LANGUAGE
GDP.SRC_SYS_D

GDPTL SOURCE_LANG

GDPTL POLICY _NAME

GDPTL POLICY_DESC

GDPTL POLICY_COMMENTS
GDPTL POLICYY_EXPRESSION
GDPTL POLICY_STATUS_DESC
GDPTL POLICY _TYPE_DESC
GDPPOLICY_PRICRITY -
GDP POLICY_EFFECTIVE_DATE —
GDP.POLICY_STATUS_CODE

GDP.POLICY _TYPE_CODE

GDP POLICY_OWNER_SID

GDP POLICY_MODIFIED_BY_SID

GDP EFFECTIVE_START_DATE

GDP EFFECTIVE_END_DATE
GDP.CURRENT_IND

GDP.BATCH_D

GDP.CREATION_DATE

GDP.CREATED_BY

GDP LAST_UPDATE_DATE
GDP.LAST_UPDATED_BY
GDP.LAST_UPDATE_LOGIN

Entitlement

r GDPTL(GRI D POLICY TL

GDP(GRI D POLICY"

B GRI_D_POLICY

POLICY_SID : NUMBER(15, 0)
POLICY_ID : NUMBER(15, 0)
POLICY_VERSION_ID : NUMBER(15, 0)
SRC_SYS_ID: VARCHAR2(S)
POLICY_PRIORITY : NUMBER(15, 0)
POLICY_EFFECTIVE_DATE : DATE
POLICY_STATUS_CODE : VARCHAR2(256)
POLICY_TYPE_CODE : VARCHAR2{(256)
POLICY_CWNER_SID : NUMBER(15, 0)

1 | POLICY_MODIFIED_BY_SID : NUMBER(15, 0)
EFFECTIVE_START_DATE: DATE
EFFECTIVE_END_DATE : DATE
CURRENT_IND : VARCHAR2(1)

BATCH_ID : NUMBER(15, 0}

[ GRI_D_FOLICY_DETAL_BG

POLICY _SID : NUMBER(15, 0)
DETAIL_SID : NUMBER(15, 0)
DETAIL_TYPE : VARCHARZ(50)
SRC_SYS_D | VARCHAR2(S)

BATCH_D : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE: DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)
<UK> GRI_D_POLICY_DETAIL_BG_U1 : PO
«Fit» GRI_D_POLICY DETAILFIT : POLIC

CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0) 1
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER{1 5, 0)

al» GRI_D_POLICY_UA : FOLICY_SID

o1 [

' [ GRID_POLICY_TC_VL

] POLICY _SID

! TOTAL_POLICY _CNT

i POLICY_ID
POLICY_VERSION_ID

1 LANGUAGE

| SRC_SYS_ID

-~~~ - - |SOURCE_LANG - — - — - -
POLICY_NAME
POLICY _DESC
POLICY _COMMENTS
POLICY _EXPRESSION
POLICY_STATUS DESC
POLICY _TYPE_DESC
POLICY _PRIORITY
POLICY_EFFECTIVE_DATE
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[E§  GRI_D_POLICY_GENERIC_DIM_BG

POLICY_SID : NUMBER(15, 0)
GENERIC_DIM_VALUE_SID : NUMBER(15, 0)
SRC_SYS_D: VARCHAR2(5)
BATCH_ID : NUMBER(15, 0)

I CREATION_DATE: DATE

CREATED_BY : NUMBER(15, D)
LAST_UPDATE DATE: DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

<Uk» GRI_D_POLICY_GENERIC_DIM__UH : POLIC
<FK» GRI_D_POLICY_GENERIC_DIM__FK1 : POLI

[E§  CGRI_D_CONTROL_PARTICIPANT_BG

CONTROL _ID : NUMBER(15, 0)
CONTROL _VERSION_ID - NUMBER(15, 0)
PARTICIPANT _SID : NUMBER(15, 0)
PARTICIPANT_GROUP _ID : NUMBER(15, 0)
ASSIGNED_TO_NAME : VARCHAR2(256)
ASSIGNED_TO_GROUP_NAWE : VARCHAR2(256)
ASSIGNED_TO : VARCHAR2(4000)
NOTIFY_TO_NAME : 'V ARCHAR2(256)
NOTIF'Y_TO_GROUP_NAME : VARCHAR2(256)
NOTIFY_TO : VARCHARZ(4000)
<Fi= GRI_D_CONTROL_PARTICIPANT_FK1 : CONTF

g ;'f GRI D POLICY WL



] GRI_D_ENTITLEMENT VL !

GDE ENTITLEMENT _SID
GDE ENTITLEMENT _ID

GDE ENTITLEMENT _VERSION_ID

GDETL LANGUAGE
GDE SRC_SYS_ID
GDETL SOURCE_LANG

[  GRLD_ENTITLEMENT_TL

ENTITLEMENT_SID : NUMBER(15, 0)
LANGUAGE : VARCHAR2(4)

SRC_SYS_D : VARCHAR2(S)
SOURCE_CANG : VARCHAR2(4) -
ENTITLEMENT_NAME : Y ARCHAR2(256)
ENTITLEMENT DESC : VARCHARZ2(1024)
ENTITLEMENT_STATUS_DESC : VARCHAR
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_B' : NUMBER(15, 0
LAST_UPDATE_LOGIN : NUMBER(15, 0)

UKz GRI_D_ENTITLEMEMT_TL_UI1 : ENTITI

£

GDETL ENTITLEMENT _NAME

GDETL ENTITLEMENT_DESC

GDETL ENTITLEMENT _STATUS_DESC
GDE EMTITLEMENT _EFFECTIVE_DATE
GDE EMTITLEMENT _STATUS_CODE
GDE EMTITLEMENT _MODIFIED_BY_SID
GDE EMTITLEMENT _CVWNER_SID

GDE EFFECTIVE_START_DATE
GDE EFFECTIVE_END_DATE

GDE CURRENT_ND
GDEBATCH_D
GDE.CREATION_DATE
GDE CREATED_BY

GDE LAST_UPDATE_DATE
GDE LAST_UPDATED_BY
GDE LAST_UPDATE_L OGIM

Generic Dimension

GDE(GRI D ENTITLEMENT) ).

B GRI_D_EMTITLEMENT

ENTITLEMENT_SID : NUMBER(15, 0)
ENTITLEMENT_ID : NUMBER(15, 0)
ENTITLEMENT_VERSION_ID - NUMBER(15,
SRC_SYS_D T VARCHAR2(S)
ENTITLEMENT_EFFECTIVE_DATE : DATE
ENTITLEMENT_STATUS_CODE : VARCHAF
ENTITLEMENT_MODIFIED_BY _SID ; NUMBE
ENTITLEMENT_OWNNER_SID : NUMBER(15, | 4
EFFECTIVE_START_DATE: DATE
EFFECTIVE_END_DATE : DATE
CURRENT_IND : VARCHAR2(1)

BATCH_D : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_B'Y : NUMBER(15, 0
LAST_UPDATE DATE: DATE
LAST_UPDATED_B' : NUMBER(15, 0)
LAST_UPDATE_LOGIN - NUMBER(15, 0)

«UkK> GRI_D_ENTITLEMENT_UZ2 | ENTITLEM 1

3

=5 GDETL{GRI D ENTITLEMENT TL}

Logical and Physical Models

[ GRI_D_ENTITLEMENT_AP_BG

ENTITLEMENT_SID : NUMBER(15, 0)
ACCESS_POINT_SID : NUMBER(15, 0)
SRC_SYS_ID: VARCHAR2(S)
BATCH_ID”. NUMBER(15, 0)
CREATION_DATE : DATE
CREATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE

" LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

<tz GRI_D_ENTITLEMENT_AP_BG_UT : E

[  GRI_D_ENTLMNT_GENERIC_DIM_BG

ENTITLEMENT_SID : NUMBER(15, 0)
GENERIC_DIM_VALUE_SID : NUMBER(15, 0)
SRC_SYS_ID: VARCHARZ(S)

BATCH_D - NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : MUMBER(15, 0)
LAST_UPDATE DATE : DATE
LAST_UPDATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

&Kz GRI_D_ENTLMNT_GENERIC_DIM_L1 : ENTITLE
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[  GRID_GENERIC_DIM_TL

GENERIC_DIM_SID : NUMBER(15, 0)

LANGUAGE : VARCHAR2(4)
SRC_SYS_ID - VARCHAR2(5)
SOURCE_LANG : VARCHAR2{d)

|_NAE : VARCHAR2(256)
GENERIC_DIM_DESC : VARCHAR2(1024)
GENERIC_DIM_STATUS_DESC: VARCHAR
BATCH_ID - NUMBER(15, 0)
CREATICN_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE

GENERIC_DI

LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

<LK GRI_D_GENERIC_DIM_TL_U1

f) GRID_GENERIC_DIM_VL

B.GENERIC_DIM_SID
B.GENERIC_DIM_ID

TL LANGUAGE

8.SRE_SYS_D

TL SOURCE_LANG
B.GENERIC_DIM_TYPE_CODE
TL GENERIC_DIM_NAME

TL GENERIC_DIM_DESC

B GENERIC_PIM_STATUS_CODE
TL GENERIC_DIN_STATUS_DESC
B.NSTANCE_SID

B EFFECTIVE_START_DATE
B.EFFECTIVE_END_DATE
B.CURRENT_IND

BBATCH D

B CREATION_DATE
B.CREATED_BY
B.LAST_UFDATE_DATE
B.LAST_UPDATED_BY
B.LAST_UPDATE_LOGIN

e Data Source

= GRI_D_GENERIC_DIf [ GRI_D_GENERIC_DIM_VAL

GENERIC_DIM_SID : NUMBER(15, 0) GENERIC_DIM_VAL_SID : NUMBER(15, 0)
GENERIC_DIV_ID - NUMBER(15, 0) GENERIC_DIM_SID - NUMBER(15, 0)
SRC_SYS_ID : VARCHARZ(S) GENERIC_DIM_VAL D : NUMBER(15, 0)
GENERIC_DIM_TYPE_CODE : VARCHARX(: SRC_SY5_ID - VARCHAR2(S)
GENERIC_DIM_STATUS_CODE : ¥ARCHAF GENERIC_DIM_VAL_STATUS_CODE : VAR
INSTANCE _SID : NUMBER(15, 0) EFFECTIVE_START_DATE: DATE
EFFECTIVE_START DATE: DATE EFFECTIVE END_DATE : DATE
EFFECTIVE_END_DATE : DATE CURRENT IND : VARCHAR2(1)
CURRENT IND : VARCHAR2(1) BATCH_ID - NUMBER(15, 0)

BATCH_ID : NUMBER(15, 0) CREATION_DATE : DATE
CREATION_DATE : DATE CREATED_BY : NUMBER(15, 0)
CREATED_BY : NUMBER(15, 0) LAST_UPDATE_DATE : DATE
LAST_UPDATE DATE: DATE LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATED_BY : NUMBER(15, 0) LAST_UPDATE_LOGIN : NUMBER(15, 0)

[  GRI_D_GENERIC_DIM_VAL_TL

GENERIC_DIM_VAL_SID : NUMBER(15, 0)
LANGUAGE : VARCHAR2(4)

SRC_SYS_ID : VARCHAR2(S)
SOURCE_LANG : ARCHARI(4)
GENERIC_DIM_VVAL_NAE : VARCHAR2(256)
GENERIC_DIM_VAL_STATUS_DESC : VARCH

[a1 |BATCHD: NUMBER(15, 0)

CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, D)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

Uk GRI_D_GENERIC_DIM_VAL _TL U1 : GE|

GENE Rt AT e NN Fi GRI_D_GENERIC DIM_VAL TL_ Fit : €
«UK» GRI_D_GENERIC_DIM_VAL U2 GEN
™ «U» GRI_D_GENERIC_DIM_UT : GENERIC_ <LK GRI_D_GENERIC_DIM_VAL L1 : GEN ]
i <Uis GRI_D_GENERIC_DIM_U2 : GENERIC_ I T
[ TLIGRI D GENERIC DIM TL) f  GRID_GENERIC_DIM_VAL VL [ BIGRI D GENERIC DIM VAL) |
] B.GENERIC_DIM_VAL_SD |
B.GENERIC_DIM_SID I
i B GENERIC_DIM_VVAL_ID I
| TLLANGUAGE
BSRC_SYS_D
TL.SOURCE_LANG 77 IL(GRI D GEMERIC DM VAL TL)
ES BIGRI D GENERIC DIM) TL.GENERIC_DIM_VAL_NAVE

B GENERIC_DIM_\/AL_STATUS_CODE
TL.GENERIC_DIM_VAL_STATUS_DESC
B EFFECTIVE_START_DATE

B EFFECTIVE_END_DATE
B.CURRENT_IND

BBATCH_D

B CREATION_DATE

B CREATED_BY
BLAST_UPDATE_DATE
BLAST_UPDATED_BY
BLAST_UPDATE LOGIN

Type s Businsss Process

{9  GRLD_GENERIC_DIM_VAL BP_VL
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=] GRI_D_INSTANCE_TL

INSTANCE_SID : NUMBER{15, 0)
INSTANCE_ID : MUMBER(15, 0)
LANGUAGE : VARCHARZ(4)
SRC_SYS_ID: VARCHARZ(S)
SOURCE_LANG | VARCHAR2(4)
INSTAMNCE_MAME : VARCHAR2({1024)
INSTAMCE_DESC : VARCHARZ2(1024)
INSTAMNCE_LOCATION : ARCHAR2({256)
INSTAMNCE_SCHEMA_MNAME : VARCHARZ(
INSTAMNCE_STATUS_DESC : VARCHARZ(1
PLATFORM_TYPE : VARCHARZ(256)
PLATFORM_DESC : VARCHARZ{1024)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : MUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
|LAST_UPDATE_LOGIN : NUMBER{15, 0)

UKz GRI_D_INSTANCE_TL_U1 : INSTANC

g GRID_INSTANCE_VL

BINSTAMCE_SID
BINSTAMCE_ID
TL LANGUAGE
TLSOURCE_LAMG
B.SRC_SYS_ID
BINSTAMCE_CODE
TL INSTANCE_NAME
TLINSTAMNCE_DESC
TLINSTANCE_LOCATION
TLINSTANCE_SCHEMA_MAME
| TLINSTAMNCE_STATUS_DESC
TLPLATFORM_TYPE
TL PLATFORM_DESC
BINSTAMCE_HOST_MAME
BINSTANCE_USER_MNAME
BINSTAMCE_PASSWORD
BINSTAMCE_PORT
BINSTAMCE_URL
BIMSTAMCE_DRINER
BINSTAMCE_STATUS
B PLATFORM_CODE
B PLATFORM_VERSION
BINSTAMCE_SYNC_DATE
B EFFECTIVE_START_DATE
B EFFECTIVE_END_DATE
B.CURRENT _IND
BEATCH_ID
B.CREATION_DATE
B.CREATED_BY
BLAST_UPDATE_DATE
BLAST_UPDATED_BY
BLAST_UPDATE_LOGIN

=

] GRI_D_INSTANCE

INSTANCE_SID : NUMBER(15, 0
INSTANCE_ID : NUMBER(15, 0)
SRC_SYS_ID: VARCHARZ(S)
INSTANCE_CODE : WARCHARZ(256)
INSTANCE_HOST_MAME : VARCHAR2(25¢
INSTANCE_USER_MAME : VARCHARZ(25¢
INSTANCE_PASSWORD : VARCHAR2(256
INSTANCE_PORT : NUMBER(15, 0)
INSTANCE_URL : VARCHAR2(258)
INSTANCE_DRIVER : VARCHAR2(256)
INSTANCE_STATUS : VARCHARZ(256)
PLATFORM_CODE : VARCHARZ(256)
PLATFORM_VERSION : VARCHAR2(256)
INSTANCE_SYNC_DATE : DATE
EFFECTIVE_START_DATE : DATE
EFFECTIVE_EMD_DATE : DATE
CURRENT_IMD : VARCHARZ(S)

BATCH_ID : NUMBER(S, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER{15, 0)
LAST_UPDATE_LOGIN : MUMBER(15, 0)

UKz GRI_D_INSTAMCE_UZ | INSTANCE_IC
UKz GRI_D_INSTAMCE_UIM | INSTANCE_S

;Hl=_ TLIGRl D INSTANCE TL)

j|:_= BIGRI D INSTANCE]
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User

[F  GRID_APPS USER_TL

APPS_USER_SID : NUMBER(15, 0)
LANGUAGE * VARCHAR2(4)
SRC_SYS_ID : VARCHAR2(50)
INSTANCE_SID : NUMBER(15, 0)
SOURCE LANG : VARCHARZ(4)
DISPLAY_NANE : VARCHAR2(258)
USER_NANE : VARCHAR2(256)
FIRST_NAIE : VARCHAR2(256)
LAST_NANE : VARCHAR2(256)
USER_DESC : VARCHAR2(1024)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0)
LAST_UPDATE DATE : DATE
LAST_UPDATED B : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

aUK» GRI_D_APPS_USER_TL_U1 : APPS_|

f] GRID_APPS_USER VL

B.APPS_USER_SID i
8.GLOBAL USER_SD =

B.GLOBAL _USER_NAME S BIGRI D APPS USER)
B RELATED_USEF_D i
TLLANGUAGE !
TL.SOURCE LANG i
B.SRC_SYS_ID

8.NSTANCE_SD !
B.DENTIFYING_VALUES !
TLDISPLAY_NANE

TLUSER_NAVE -
TLFIRST_NAME b
TLLAST_NAUE

TLUSER_DESC

B.USER_START_DATE

B.USER_END_DATE

B EMPLOYEE_D

B.APPS_USER_STATUS
TL.APPS_USER_STATUS_DESC

B EFFECTIVE_START_DATE

B EFFECTIVE_END_DATE

6 CURRENT D

B.5ATCHID

B.CREATION_DATE

B.CREATED_BY

B.LAST_UPDATE_DATE
B.LAST_UPDATED_BY

(] ORLD_APPS_USER_ALL_VL

Time

GRI_D_APPS_LISER

APPS_USER_SID * NUMBER(15, 0)
GLOBAL _USER_NAME : VARCHAR2(256)
RELATED_USER D : /ARCHAR2(256)
SRC_SYS_ID : VARCHAR2(50)
INSTANCE_SID : NUMBER(15, 0)
IDENTIFYING _\VALUES : VARCHAR2(256)
USER_START DATE : DATE
USER_END_DATE : DATE
EMPLOYEE ID - NUMBER(15, 0)
APPS_USER_STATUS 1 VARCHARR(256)
EFFECTIVE_START DATE : DATE
EFFECTIVE_END_DATE : DATE

4 |CURRENT_IND : VARCHAR2(1)

- BATCH_ID : NUMBER(15, 0)

CREATION_DATE : DATE
CREATED_B'Y : NUMBER(15, 0)
LAST_LPDATE DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)
«UK> GRI_D_APPS_USER_U1 : RELATED_USER |
«UK= GRI_D_APPS_USER_UK1 : APPS_USER_SI

= GRI_D_GBL_USER

GLOBAL _USER_SID': NUMBER(15, 0)
GLOBAL _USER_NAME : VARCHAR2(256)
SRC_SS5_ID : VARCHAR2(50)
BATCH D NUMEER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0}
LAST_UPDATE_LOGM : NUMBER(15, 0)

UK GRI_D_GBL_USER_U1 - GLOBAL U
<UKs GRI_D_GBL_USER_U2: GLOBAL U

IL(GRI D APPS USER TL)

[=] GRCD_USERS

GRCD_USER_SID : NUMBER(15, 0)
USER 1D : NUMBER(15, 0)
SRC_SYS_ID : VARCHAR2(S)
USERNAME : NVARCHAR2(765)
GROUPNAME : NVARCHAR2(1500)
DISPLAYNANE : NVARCHAR2(1500)
PASSINORD : NVARCHAR2(765)
LOGLEVEL : NUMBER(1, 0)
USER_EMAIL ID_{ : VARCHAR2(240)
USER_EMAIL_ID_2: VARCHAR2(240)
TMOBILE_PHONE : ARCHAR2(30)
USER_STATUS : VARCHAR2(S0)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE
CREATED_B'Y : NUMBER(15, 0)
LAST_UPDATE DATE : DATE

Ui GRCD_USERS_UKT : GRCD_USER

f] ORCD_USERS_VL

B.SRC_SYS_D

' TL.SOURCE_LANG
| TLUSER_NAME_DESC

TLFRST_NAME
TLLAST_NAME
TLUSER_STATUS_DESC
TLUSER_ADDR

h B USERNAME
' B.GROUPNAIE

B DISPLAYNANE [
B.PASSWORD j

B.LOGLEVEL

Superset of Applcation
Users and Global Lisers

B .USER_EMAIL_ID_1
B USER_EMAIL_ID_2

B MOBILE_PHONE
B.USER_STATUS
B.BATCH ID

GRCC Users
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[) GRCD_USERS_TL

GRCD_USER_SID : NUMBER(15, 0)
LANGUAGE : VARCHAR2(4)
SRC_SYS ID: VARCHAR2(S)
SOURCE_LANG : VARCHAR2(4)
USER_NAME_DESC : VARCHAR2(1024)
FIRST_NAME : VARCHAR2(256)
LAST_NAME : ¥ARCHAR2(256)
USER_STATUS_DESC : VARCHAR2(1024)

* |USER_ADDR: VARCHAR2(1024)

BATCH D : NUMBER(15, 0)

CREATION_DATE : DATE

- |CREATED_BY : NUMBER(15, 0)

| |LAST_UPDATE DATE : DATE

| |LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : VARCHAR2(15)

[ B(GRED USERS)

TLIGRCD USERS TL)



] GRCD_TIME_TL ] GRCD_TIME_D

TIME_KEY : NUMBER(30, 0) TIME_KEY : NUMBER(30, 0)
LANGUAGE : YARCHAR2(10) CREATE_DT : DATE

SOURCE_LANG : VARCHARZ2(1D) | ' | TIME_DT : DATE

LOCALE : VARCHAR2{10) - DAY_NAME : NV ARCHAR2(90)
DAY_MAME : NVARCHAR2(50) DAY_NBR : NUMBER
LAST_DAY_IN_MTH_IND : NVARCHAR2(3! LAST_UPDATE_DT: DATE

MTH_MANE : Ny ARCHAR2(90) LAST_DAY_IN_MTH_IND : NV ARCHAR2(3'
QTR_MAME : NVARCHAR2(90) MTH_MAME - Ny ARCHAR2(90)

HOLIDAY _IND : NVARCHAR2(30) MTH_NER : NUMBER

WKDAY_IND : NVARCHAR2(30) QTR_MAME : NVARCHAR2(90)
DAY_ABBREV : NVARCHAR2(30) GTR_MBR : NUMBER

MTH_ABBREY : MY ARCHAR2(30) YR_MTH : NUMBER

YR_NBR : NUMBER
WK_END_DT : DATE
WK_START_DT : DATE

VWK _NBR : NUMBER
DAY_NBR_OVERALL : NUMBER
i DAY_OF WK : NUMBER
HOLIDAY _IND : N ARCHAR2(3)
WKDAY_IND : NVARCHAR2(3)
DAY_ABBREY : N\VARCHAR2(30)
MTH_NBR_OVERALL : NUMBER
MTH_ABEREY : N\VARCHAR2({90)
! YR_QTR : NUMBER

WK _NBR_OVERALL : NUMBER

| QTR_NBR_OVERALL : NUMBER
f3) GRCD_TIME_VL

BASE TIME_KEY ST .
TL LANGUAGE

TL.SOURCE_LANG

TL.LOCALE

BASE CREATE_DT

BASE.TIME_DT

TL.DAY_NAME

BASEDAY_NER

BASELAST_UPDATE_DT

TL.LAST_DAY _IN_MTH_IND

TL.MTH_MAME

BASE MTH_NER

TL.QTR_MAME

BASE QTR_MER

BASE.YR_MTH

BASE.YR_MBR

BASEWHK_END_DT

BASEWHK_START_DT

BASE WHK_NBR

BASEDAY_NBR_OVERALL

BASEDAY_OF_WK

TLHOLIDAY_IND

TLAWKDAY_ND

TL.DAY_ABBREV

BASE MTH_NBR_OVERALL

TL.MTH_ABBREV

BASE.YR_QTR

BASEWHK_NBR_OVERALL

BASE QTR_NBR_OVERALL

| &UK» GRCD_TIME_D_UK1 : TIME_KEY

¢ GRCCRole
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= GRI_D_ROLE_TL = GRI_D_ROLE ] GR|_D_ROLE_USER_BEG

ROLE_SID : NUMBER(15, 0) ROLE_SID : NUMBER(15, 0) ROLE_SID : NUMBER(15, 0)
LANGUAGE : VARCHAR2(4) ROLE_ID : NUMBER(15, 0) GRCD_USER_SID : NUMBER(15, 0)
SRC_SYS_ID : VARCHAR2(S0) SRC_SYS_ID : VARCHAR2(50) SRC_SYS_ID : VARCHAR2(50)
SOURCE_LANG : VARCHAR2(4) EFFECTIVE_DATE : DATE ROLE_USER_STATUS_SID : NUMBER(15, (
ROLE_NAME : VARCHAR2(258) ROLE_STATUS_CODE : VARCHAR2(256) EFFECTIVE_START_DATE: DATE
ROLE_DESCRIPTION : \VARCHAR2(1024) , |EFFECTIVE_START_DATE: DATE EFFECTIVE_END_DATE : DATE
ROLE_STATUS_DESC : VARCHAR2{1024)_ ' |EFFECTIVE_END_DATE: DATE " | CURRENT_IND : VARCHAR2(1)
BATCH_ID : NUMBER(15, 0) k CURRENT_IND : VARCHAR2(1) I “|BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE BATCH_ID : NUMBER(15, 0) CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0) CREATION_DATE : DATE CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE I~ CREATED_BY : NUMBER(15, 0) LAST_UPDATE_DATE : DATE
LAST_UPDATED_B'Y : NUMBER(15, 0) ! LAST_UPDATE_DATE : DATE LAST_UPDATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER{15, 0) : LAST_UPDATED_B' : NUMBER(15, 0) LAST_UPDATE_LOGIN : NUMBER(15, 0)

| LAST_UPDATE_LOGIN : NUMBER(15, 0)

«UK» GRI_D_ROLE_U1 : ROLE_SID
«Uk» ORI D_ROLE_U2 - ROLE_D, SRC_S" «UK» GR|_D_ROLE_USER_BG_U1 : ROLE_
i - - Fis GRI_D_ROLE_USER_BG_GRI_D__FK

«UK» GRI_D_ROLE_TL_U1 : ROLE_SID, L&

B2 GRI_D_ROLE_VL

BROLE_SID ]
BROLE_ID i
TL LANGUAGE i | BIGRI D ROLE)
BSRC_SYS_ID !

TL SOURCE_LANG

TL ROLE_MAME |
TL ROLE_DESCRIPTION

TL ROLE_STATUS_DESC

B EFFECTIVE_DATE

B ROLE_STATUS_CODE

B EFFECTIVE_START_DATE
B EFFECTIVE_END_DATE

B .CURRENT_IND
BBATCH_ID
B.CREATION_DATE
B.CREATED_BY
BLAST_UPDATE_DATE
BLAST_UPDATED_BY
BLAST_UPDATE_LOGIN

;ll’_= TLIGRI D ROLE TL)

e Control Detail Star

{53 GRID_POLICY DETAL_V

POLICY_SID
# TIME_KEY
ACCESS_POINT_SID
ENTITLEMENT_SD
DETAIL_TYPE
ENTITLEMENT _ACCESS_POINT_SID
ALL_ACCESS_POINT_SID
INSTANCE_SID
,,,,,,,,, 5 INSTANCE_SID1

f) ORI D_ACCESSPONT ML — _ ———_____ | £ GRLD_POLICY_TC_VL

GRI_D_ENTITLEMENT_VL 3 GRCD_TIME_VL
il il

£ ORI_D_INSTANCE VL f#] GRID_POLICY_INSTANCE FLAG_V

e Incidents - All Star
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[ oRID_PoLICY

[ GRID_INSTANCE

GRI_D_INCIDENT_DATASOLRCE_BG

=)

s

[ GROC_LOV

1 Incident Stetus

[ GRec_LOVTL

[ GRED_TME_D

Incident Access

[ GRID_ACCESS _POINT

[E GRI_D_ACCESS_POINT_ROLE

GRI_F_TCG_INCIDENT

() GRL_F_INCIDENT_ALL

INCIDENT _ID : /ARCHAR2(256 CHAR)
INCIDENT_VERSION D : NUMBER(13, 0)
CONTROL_SID : NUMEER

DATASOURCE_SID : NUMBER

CONTROL 1D : NUMBER

INCIDENT _TYPE_D : NUMBER(19, 0)
INCIDENT_TYPE_CODE : YARCHAR2(255 CHAR)
INCIDENT_STATUS D NUMBER(18, 0]

)
> INCIDENT_STATUS_CODE : VARCHAR2(255 CHAR)

INCIDENT_CREATED_DATE : DAT!
INCIDENT_CLOSED_DATE : DATE
INCIDENT_UPDATED_DATE : DATE
CONTROL_LAST RUN_DATE : DATE
INCIDENT_COMMENTS | ARCHAR2(4000 CHAR)
ASSIGNED_TO : VARCHAR2(4000 CHAR)
INCIDENT_VERSION_START_DATE: DATE
INCIDENT_VERSION_END_DATE : DATE
SRC_SYS_ID : VARCHAR2(S CHAR)
CURRENT_IND | VARCHAR2(1)

BATCH_ID : NUMBER

CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE: DATE
LAST_UPDATED_BY : NUMBER(1S, 0)
LAST_UPDATE_LOGIN: NUMBER(1S, 0)

E

[ GRL_F_NCIDENT_ACCESS

GRI_F_INCIDENT_ACCESS

]

T |USER_SID: NUMBER
ROLE_SID : NUMBER

PRIVILEGE _SID : NUMBER
CONTROL_ID : NUMBER
SRC_SS_ID | VARCHAR2(S CHAR)
BATCH_ID : NUMBER
CREATION_DATE : DATE
CREATED_BY : NUMBER
LAST_UPDATE_DATE : DATE
LAST_UPDATED_B' : NUMBER
LAST_UPDATE_LOGIN : NUMBER

\[Ff] GRI_D_GBL_USER

Incident Transaction

1

GRI_D_INCIDENT_PARTICIPANT_BG

~ ~|F@ GRID_INCIDENT_TAG_BG

GRCD_USERS_VL

]

Incident Participarnt

{8 GRID_GENERIC_DIM_VAL VL

Tags

GRI_D_GENERIC_DIM_VAL_BP_VL

i

Business Process

{2 GRID_GENERIC_DIM_VAL RISK_VL

Risk

INCIDENT_ID : v ARCHARZ{256 CHAR)

-~~~ — _ > GRL_F_INCIDENT_ALL

Logical and Physical Models
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[ GRIF_INCIDENT_ALL

Conditions Star

e

[ GRILD_GENERIC_DIM

& GRI_D_GENERIC_DIM_VAL

[ GRI_D_APPS_USER

| CONDITION_TYPE_SID = -89

[l GRI_D_ACCESS_POINT

| CONDITION_TYPE_SID = -259

Path Conditions Star

]

GRI_F_TCG_INCIDENT

INCIDENT_SID : 'Y ARCHAR2(255 CHAR)
CONTROL_ID : NUMBER(15, 0)
SRC_S'YS_D: VARCHAR2(S CHAR)
ATTR_VALUE_1 : VARCHARZ2(255 CHAR)
ATTR_VALUE_2 : VARCHAR2{255 CHAR)
ATTR_VALUE_3: VARCHARZ2{255 CHAR)
ATTR_VALUE_4 : VARCHAR2{255 CHAR)
ATTR_VALUE_S : VARCHAR2(255 CHAR)
ATTR_VALUE_G : VARCHAR2{255 CHAR)
ATTR_VALUE_7 : VARCHARZ2{255 CHAR)
ATTR_VALUE_S : VARCHARZ2(255 CHAR)
ATTR_VALUE_O : VARCHAR2{255 CHAR)
ATTR_VALUE_10: WARCHAR2(255 CHAR) € — — — — — — — |
ATTR_VALUE_11 : WARCHAR2(255 CHAR)
ATTR_VALUE_12: WARCHAR2(255 CHAR)
ATTR_VALUE_13: WARCHAR2(255 CHAR)
ATTR_VALUE_14 : WARCHAR2(255 CHAR)
ATTR_VALUE_15: WARCHAR2(255 CHAR)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER{15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

] GRI_F_CONDITION

COMDITION_TYPE_SID : NUMBER(15,0) |
| INSTANCE_SID - NUMBER(15, 0) :
CONTROL _SID : NUMBER(15, 0)
| CONDITION_'ALUE_SID : NUMBER(15, 0)
SRC_SYS_ID: VARCHAR2(S)
COMDITION_NAME : VARCHAR2(256) |
| CONDITION_DESCRIPTION : VARCHAR2(2¢
| CONDITION_STATUS : NUMBER(15, 0)
FILTER_NAME : VARCHARZ2(256)
OBJECT_NAME : 'ARCHAR2(256) =
OPERATION : Y ARCHAR2(50)
OPERATION_TYPE : ' ARCHAR2(256)
|EXCLUDE_FLAG : NUMBER(15, 0)
LOCALE_KEY : VARCHAR2(30)
BATCH_ID : NUMBER(15, 0)
| CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0)

F—————— - »LAST_UPDATE_DATE : DATE

LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)
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i GRI_A_TCG_CNTRL_ATT LABELS

COMTROL _ID : NUMBER(15, 0
LANGUAGE : VARCHAR2(S CHAR)
SRC_SYS_ID: VARCHAR2(S CHAR)

SOURCE_LANG :

ATTR_NAME_1 :
ATTR_NAME_2 :
ATTR_NAME_3 :
ATTR_NAME_4 :
ATTR_NAME 5 :
ATTR_NAME 6 :
ATTR_NAME_7 :
ATTR_NAME_8 :
ATTR_NAME S :
ATTR_NAME_10
ATTR_NAME_11
ATTR_NAME_12
ATTR_NAME_13
ATTR_NAME_14
ATTR_NAME_15

WARCHAR2(S CHAR)
VARCHAR2(255 CHAR)
VARCHARZ2(255 CHAR)
VARCHAR2(255 CHAR)
WARCHARZ(255 CHAR)
VARCHARZ(255 CHAR)
VARCHARZ2(255 CHAR)
VARCHAR2(255 CHAR)
VARCHAR2(255 CHAR)
VARCHAR2(255 CHAR)

- WARCHAR2(255 CHAR)
- WARCHAR2(255 CHAR)
- WARCHAR2(255 CHAR)
- WARCHAR2(255 CHAR)
- WARCHAR2(255 CHAR)
- WARCHAR2(255 CHAR)

BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

1 | GRL_D_POLICY

1 |[E] GRI_D_NSTANCE



[&] GRI_D_PATH_EXCLUSION

INSTAMCE_SID : MUMBER(15, 0)
ACCESS_POINT_SID : NUMBER(15, 0)
FROM_USER_SID : NUMBER(15, 0)
[ GRID_ACCESS_POINT FROM_ACCESS_POINT_SID : NUMBER(15, 0
SRC_SYS_ID : VARCHAR2(S)
1 EXCLUSION_ACTION_SID : MUMBER{15, 0} 1
EXCLUSION_STATUS_SID : NUMBER(15,0) ——————
START_DATE: DATE E GRI_A_LOOKUP
END_DATE : DATE
BATCH_D : NUMBER(15, 0) - -
CREATION_DATE : DATE FATESnE A
CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE: DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

[ GRI_D_ACCESS_POINT_FROM

[ 1

alias of Access Point L ] GRLA_LOOKUP_EXCLUSION_STATUS
<UK> GRI_D_PATH_EXCLUSION_UT : INSTAN | Exclusion Status (alias of
GRI_A_LOOKUPY)
[ GRID_APPS_USER K]

[ GRI_D_INSTANCE

User Access Star
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B GRID_APPS_USER [ GRID_INSTANCE

[Ff] GRI_D_USER_ACCESS_BG

ACCESS_POINT_SID : NUMEER

USER_SID : NUMBER

INSTANCE _SID : NUMBER

START_DATE_SID : NUMBER |

START_DATE : DATE -

END_DATE : DATE

DELETE_FLAG : VARCHAR2(1)

* |SRC_SYS_D: VARCHARZ(S)
|BATCH_ID : NUMBER =
CREATION_DATE : DATE
CREATED_BY : MUMEER
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMEER
LAST_UPDATE_LOGIM : NUMBER

GRI_D_ACCESS_POINT GRCD_TIME_D
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This appendix covers the following topics:

GRCI 3.0.2 - GRCC 8.6.0, Data Lineage DIMENSIONS Table

GRCI 3.0.2 - GRCC 8.6.0, Data Lineage BRIDGES Table

GRCI 3.0.2 - GRCC 8.6.0, Data Lineage FACTS Table

GRCI 3.0.2 - GRCC 8.6.0, Data Lineage DIMENSIONS Table

The following table illustrates lineage of Dimensions used in GRCI. It contains the
GRCC 8.6.0 source table name that loads the GRCI dimensions, the sql scripts file
name, and the file that contains the load procedure.

Lineage for GRCC 8.6.0

It is important to note that all these packages are invoked from GRI_MASTER_PKG.

Common Table Values

The following parameters have common values for all rows in this table.

Master Package: GRI_ MASTER_PKG

Dimensions Package : GRI_DIMENSIONS_PKG

Dimension/Bridg

Source Table Name

SREC_DA_INSTANCE

Target Table Mame _ Load Type Master Package e Table Package

GRLD_INSTANGE

o1

GRIMASTER_FEG

GRLDIMENSIONS_Pis

Package Name
GRS TANCE_FiE

Sub-Package Name
SRLD_INETANCE PG

Interface Name
SRLD_INSTANCE_INTR

[GRGG_DAINETANCETL GRLD_INSTANGE_TL o1 [GRIMASTER_FKG | GRLDIMENSIONS_FKG _|GRLINSTANGE_FK& [GRLO_INSTANCE_TLFKG [GR.LD_INSTAHCE_TLINTR.
[GREG_DA_GEHERIC_DIM FI_D_GENERIC_DIM o1 [GRILMASTER_PKG | GRLLDIMENSIONS_PKG | GRLGENERIC_DIM_PKG F_D_GENERIC_DIM_PKG Fi_D_GENERIC_DIM_INTF:
GREG_DA_GENERIC_DIM_TL FI_D_GENERIC_DIM_TL ool GRIMASTER_ PG| GRLDIMENSIONS_PKG | GRL GENERIG_DIM PG FiL_D_GENERIC_DIM_TL_PKG FiL_D_GENERIC_DIM_TL_INTF:
[GRCC_DA_GENERIC_DIM_¥AL FI_D_GEERIC_DIF_VaL oo [GRI_MASTER_FKG | GRI_DIMENSIONS_FRG | GRL GENERIC_DIM_FKG Fi_D_SENERIE_DIM_VAL_FFKG Fi_D_GENERIC_DIM_VAL_INTR
[GR0G_DA_GENERIC_DIM_#aL_TL FI_D_GEHERIC_DIM_PAL_TL __[oD1 [GRIMASTER_FKG | GRLDIMENSIONS_FKG | GRLGENERIC_DIM_FKE Fi_D_GENERIC_DIM_YAL_TL_FK& Fi_D_GENERIC_DIF_¥AL_TL_INTF:
GROG_DA_AG_USER GRGD_USERS ool GRIMASTER_PKEG | GRLDIMENSIONS_PEG | GROD_USER_MAIN PEG GROD_USER_PKE GRCD_USER_INTR
(GREG_DA_AG_USER_TL GRGD_USERS_TL ol GRIMASTER_PEG | GRLDIMENSIONS_PRG | GROD_USER MAIN PEG (GROD_USER_TL PHG (GROD_USER_TLINTR
GRIS_AG_AFFS_USER FI_D_GEL_USER: oo [GRIMASTER_FKG | GRILMASTER_FKG [GRI_AFFS_USER_FKG [GRLO_AFFE_USER_FKS FI_GEL_USER_PROC

W[ 5Rc6_bA_GONTROL GR_D_FOLIGT o1 [GRIMASTER_FKG | GRLDIMENSIONS_FKG_|GRLPOLIGI_FKG [GRLO_FOLIG_FKG [GR.LD_F OLIGT_IHTR
GROG_DA_GOHTROL_TL GR_DPOLIGY_TL ool GRIMASTER_PKEG | GRLDIMENSIONS_PKG | GRL POLIGY_PKG GRLD_POLICY_TL_PKG GRLD_FOLIGY_TLINTR
[GRUG_DA_ENTILEMENT RID_ENTITLEMENT oo GRIMASTER PKG | GRLDIMENSIONS_ PG _|GRL ENTITLEMENT_FRG FiL_D_ENTILEMENT_PrG FiL_D_ENTILEMENT_INTR
[GRCC_DA_ENTITLEMENT_TL FI_D_ENTITLEMENT_TL oo GRI_MASTER_FKG | GRILDIMENSIONS_FKG _|GRLENTITLEMENT_FKG FI_D_ENTILEMENT_TL FK& Fi_D_ENTILEMENT_TL INTR
[GRGG_DA_ACCESS_FOINT GRLD_AGCESS_FOINT o1 [GRIMASTER_FKG | GRLDIMENSIONS_FKG_|GRIAGGESS_FOINT_FKG [GF.LO_ACGESS_FOINTFEG [GF.LD_ACCESS_FOINT_INTE:
GREG_DA_ACCESS POINT_TL GRLD_AGOESS_POINT_TL ool GRIMASTER_PKG | GRLDIMENSIONS_PKG _|GRL AGGESS_POINT_FKG GRLD_ADGESS_FOINT_TL_PKG GRLD_ADGESS_POINT_TL_INTR
[SROC_DA_AG_AFFS_USER GRL_D_AFFS_USER o1 [GRI_MASTER_FKG | GRIDIMENSIONS_FKG | GRL AFFS_USER_FKG [GRLO_AFFE_USER_FKG [GRLD_APFS_USER_INTR
[GREC_DA_AG_AFFE_USER_TL GRL_D_AFFS_USER_TL oo [GRI_MASTER_FKG | GRIDIMENSIONS_FKG | GRL AFFS_USER_FEG [GRL_D_AFFS_USER_IL_FrG GRL_D_AFFS_USER_TL_INTR

EE FOLE GRLD_FOLE o1 [GRIMASTER_FKG | GRLDIMENSIONS_FKG_|GRLAOLE_FK& FID_ROLE_FKG FI_D_ROLE_INTR.

18] GRL ROLE TL Ril_D_ROLE_TL a01 GRILMASTER PKG | GRLDIMENSIONS PKG [GRILROLE PG Fil_0_ROLE TL_PKG il 0_ROLE TL_IHTF:

0] GReCC_DA_FATH EXCLUSION GRI_D_PATH_EXCLUSION oo1 GRLMASTER_FKG | GRLDIMENSIONS_PEG [ GRI_EXCLUSION FKG SR|_0_FATH EXCLUSION FKG SR|_D_FATH EXCLUSION_INTF.

GRCI 3.0.2 - GRCC 8.6.0, Data Lineage BRIDGES Table

The following table illustrates lineage of Bridges used in GRCI. It contains the GRCC
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8.6.0 source table name that loads the GRCI bridges, the sql scripts file name, and the
file that contains the load procedure.

The following parameters have common values for all rows in this table.
Common Table Values
The following parameters have common values for all rows in this table.

® Master Package: GRI_MASTER_PKG

Bridges Table Package : GRI_BRIDGE_TABLES_PKG

Dimension/Bridge

Source Table Name Target Table Name  Load TypeMaster Package  Table Package Package Name Interface Name

1| GRCC_DA_AG_ROLE_USER_BG GRLO_ROLE_USER_BG ool GRI_MASTER_PKG | GRI_BRIDGE_TABLES_PH GRI_O_ROLE_USER_BG_PKG GRI_O_ROLE_USER_BG_INTR
GRLS_POLICY_GENERIC_DIM_BG GRLO_POLICY_GENERIC_DIM_E ODI GRI_MASTER_PKG | GRI_BRIDGE_TABLES_PH GRI_O_POLICY_GENERIC_DIM_BG_PH GRILD_POLICY_GENERIC_DIM_BG_INTR
GRLS_POLICY_DETAIL_BG GRLO_POLICY_DETAIL_BG ool GRI_MASTER_PKG | GRI_BRIDGE_TABLES_PH GRI_O_POLICY_DETAIL_BG_FKG GRI_O_POLICY_DET AIL_BG_INTR:
GRCC_DA_ENTLMNT_GENERIC_DIM_EG GRLO_ENTLMMT_GENERIC_DIN 001 GRI_M&STER_PKG | GRLBRIDGE_TABLES_PH GRI_O_ENTLMMNT_GENERIC_DINM_EG ] GRLO_ENTLMNT_GENERIC_DIM_BG_INTR
GRCC_DA_ENTITLEMENT_&P_EBG GRLO_ENTTLEMENT_AP_EG ool GRI_M&STER_PKG | GRLBRIDGE_TABLES_PH GRL_O_ENTTLEMENT_AP_BG_PEG GRIL_O_EMTITLEMENT_AP_BG_INTH
GRI_I_UIER_ACCESI_BG

B|GRLDO_ACCESS_POINT GRLO_USER_ACCESS_BG ool GRI_MASTER_PKG | GRI_BRIDGE_TABLES_PH GRI_O_USER_ACCESS_BG_PKG GRI_O_USER_ACCESS_BG_INTR

GREC_DA_ITSUE
GRLO_GENERIC_DIM_VAL
GRLD_GENERIC_DIM GRLD_INCIDENT_TAG_EG ool GRI_MASTER_PKG | GRI_FACTS_PKG GRLD_INCIDENT_TAG_ BG_PKG LOAD INCIDENT_ TG BG_PROC
GRCC_DA_ISSUE

GRCO_USERS, GRCO_USERS_TL

~

GREC_DA_CONTROL_OBSERVER
GREC_DA_PARTIGIPANT,

#| GRCC_DA_PARTICIFANT_TL GRLD_INCIDENT_PARTICIEANT |00 GRI_MASTER_PKG | GRI_FACTS_PKG GRI_D_INCIDENT_PARTICIFANT_BG_) LOAD_INCIDENT_PARTICIPANT_BG_PROC
GREC_DA_CONTROL_OBSERVER
9| GRCO_USERS GRLD_CONTROL_PARTICIFANT| 001 GRI_MASTER_PKG | GRI_FACTS_PKG GRID_CONTROL_PARTICIFANT_BG_| LOAD CONTROL_PARTICIFANT_BG

GRCI 3.0.2 - GRCC 8.6.0, Data Lineage FACTS Table

The following table contains the GRCI staging table name that loads the GRCI fact
tables, and the package that loads the target GRCI fact table.

Note: It is important to note that all these packages are invoked from
the fact package GRI_FACTS_PKG, which in turn is invoked from
GRI_MASTER_PKG.

Common Table Values
The following parameters have common values for all rows in this table.

¢ Load Type: ODI
e Master Package: GRI_MASTER_PKG
e Fact Package GRI_FACTS_PKG

Facts Package: GRI_FACTS_PKG

51 NO. Source Table Name Target Table Name Load Type Master Package Fact Package Package Name Interface Name
1|GRCC_Da_ISSUE_ATTR YALUE | GRI_F_TCE_INCIDENT ool GR_MASTER_PKG GRIFACTS_PKG GRIF_TCG_INCIDENT_PKG | GRIF_TCG_INCIDENT_INTR
GRCC_O4_ISSUE
2|GRI_0_POLICY GRL_F_INCIDEMT_ALL ool GR_MASTER_PKG GRIFACTS_PKG GRIF_INCIDENT_ALL_PKG GRLF_INCIDENT_ALL_INTR

GRCC_DA_ISSUE
GRI_O_AFPS_USER
3| GRL_O_ACCESS_POINT GFR_F_IMCIDENT_ACCESS ool GRI_MASTER_PKG GRI_FACTS PKG | GRI_F_IMCIDENT_ACCESS_PKG| GRI_F_INCIDENT_ACCESS_IMTR
GFI_O_GENERIC_DIM_VAL_YL
GRCC_DA_CONDITION

GRI_O_POLICY GRI_F_COMDITION_INTR1
GRI_D_ACCESS_POINT_YL GRI_F_COMDITION_MTF2
4| GRL_D_APPS_USER Y GFRI_F_COMDITION ool GRI_MASTER_PKG GRI_FACTS PKG | GRIF_COMDITION_PKG GRI_F_COMDITION_MTF:
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D

Data Flow, B-1
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AACG, D-1

E
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Entitlement, C-6

ETL Execution GRCC, A-2
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Sequence, A-1

Execution, 2-8
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Facts AACG, D-2

Index
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overview, 1-1
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Incident Access, C-13

Incidents, C-1

Incidents - All Star, C-12

Incident Transaction, C-13

Install GRCI Overview
GRCC 8.6.0, 2-1

Install Preparation, 2-4

(0

OBIEE
Installing reports, 2-21
ODI Code, 2-9

P

Package, A-3

Path Conditions, C-3

Path Conditions Star, C-14
Prerequisites for Install, 1-2
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